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1. BASIC PRINCIPLES 
 

Every master's/doctoral thesis must be an original work. In addition to the requirement that 

the study meet the academic standards of the master's/doctoral program, the writing of the study 

must also meet the following rules of the Institute of Graduate Education at Istinye University  

In order for the theses, thesis proposals, projects and reports to be submitted to the thesis 

monitoring committee to be accepted to Institute of Graduate Education at Istinye University, 

they must be prepared in accordance with the rules specified in this guide. This guide contains 

information explaining the content, writing rules and formal features of the Master's and 

Doctoral theses to be delivered to the Institute of Graduate Education at the end of the academic 

research and thesis studies at Istinye University. 

1.1. Preparation and Submission of the Thesis 

Theses must be prepared electronically using appropriate software. In accordance with the 

decision taken by the Council of Higher Education in its session dated 10/03/2006, during the 

submission of Master's and Doctoral theses to the Institute, 2 CDs containing the full text of the 

thesis, the "Thesis Approval Page" and the "Permission Document for Duplication and 

Publication of Theses" and the "Thesis Data Entry Form" must also be submitted to the Institute. 

The thesis must be submitted to the Institute as a spiral copy before the exam. In these 

copies, on the Thesis Approval page, the jury members' names and exam date sections will be 

left blank and other fields will be filled. After the exam, in accordance with the regulations, one 

hardcover hard copy must be submitted for review within one month, and after the approval of 

the Institute, three hardback hard copies (printed with wet signed approval pages), two CDs and 

other necessary documents must be submitted. 

While writing your theses, please use the THESIS TEMPLATE. 
 
1.2. Theses with Patentable Information 

 
If the thesis contains patentable information, a maximum period of 90 days may be 

requested before the thesis is made public. If the request is accepted by the Institute of Graduate 

Education Board of Directors, your thesis will not be made public during this period. This 

period starts from the official graduation date. 

1.3. Citing Previous Studies and Plagiarism 

Academic ethics must be followed in preparing the thesis. The student must prepare his or 
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her project or thesis himself or herself. The rules of citing and quoting must be strictly followed. 

Research data should be obtained from reliable sources and should not be corrected or altered 

for any reason. 

Using other people's ideas or findings as your own is plagiarism. It is not only unethical 

but also a crime. Therefore, in the original work, it is necessary to write in a way that clearly 

distinguishes one's own ideas and work from those of others. 

The Thesis Plagiarism Report is received by the institute through the Turnitin Plagiarism 

Detection Program. By the decision of the Board of Directors of the Institute of Graduate 

Education, the upper limit of the similarity rate has been determined as 25% for master's 

degrees and 20% for doctoral degrees. The first page of the Plagiarism Report showing the total 

"% similarity rate" of the thesis and the date the report was received is printed and submitted to 

the institute by placing it in the "Plagiarism Report" section of the thesis. If the thesis receives 

an extension after defense and/or contains extensive changes, the plagiarism report must be re-

created and submitted to the Institute. 

If your study involves a procedure that may have a physical or psychological effect on 

animals or humans, or involves the administration of drugs, you must start your study after 

obtaining permission from the relevant ethics committee. In addition, you must comply with 

general ethical behavior during your work (if you are going to use a laboratory or device in 

another institution, written permission from the official of that institution and informed consent 

from the people providing materials or information, etc. are required). Acknowledge these in 

your thesis. 

Avoid violating patents (a document showing that an invention or the right to use that 

invention in its field of application belongs to someone). If you have used a patented method 

or patented materials, technologies or processes, you must obtain written permission from the 

patent owner. State this in your theses. 

Avoid violating copyrights (all the rights of the person who creates an intellectual / artistic 

work or similar works arising from this work, copyright, author's right). If you are going to use 

a copyrighted emblem, etc., while writing your thesis, obtain written permission and indicate 

this in the thesis. 
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2. GENERAL APPEARANCE AND WRITING RULES 

2.1. Paper 

Theses should be written on one side of an A4 standard, white, first quality pulp paper (21 

x 29.7 cm, 80 g/m2) in a computer environment. Their printouts should be taken from laser or 

inkjet printers. They should be copied without any of their features lost, and the copies should 

be clean and legible. Erasures, scrapings or manual corrections are not accepted on the thesis. 

2.2. Page Structure 

In the thesis, there should be a space of 3.5 cm from the left edge of the page, 3 cm from 

the top edge and 2.5 cm from the other edges. All headings, text, tables, page numbers and 

footnotes must remain within these limits. 

2.3. Font 

The thesis must be written using Times New Roman font, 12-point font size. Table headings 

and image captions use fonts that are one degree smaller than the main text, or smaller when 

necessary (in case of space constraints, letters can be reduced to 8-point font size). Formats 

such as bold, italic, bold italic and underline should not be used in the thesis text, except when 

required by the relevant scientific field. Font type and size should be consistent throughout the 

thesis. There should be a one-character space after punctuation marks. 

2.4. Page Numbering 

All pages of the thesis are numbered except the outer cover, inner cover and approval page. 

All page numbers must have a font size of 11 points. Lowercase Roman numerals (i, ii, …) are 

used on the front pages, and the rest - starting from the main thesis text - are numbered with 

Latin numerals (1, 2, …) in the middle of the bottom of the page. 

2.5. Thesis Cover and Binding 

The outer cover should be prepared using good quality matboard. The thesis text, together 

with its appendices, must be compiled into a single volume after the exam. All master's and 

doctoral theses must be prepared in white binding, and their cover letters must be in plain text. 
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3. RULES FOR THE CHAPTERS OF THE THESIS 

The order given below should be followed for the chapters in the entire thesis. 

MAIN CHAPTERS SECTIONS 

 
OUTER COVER 

FRONT OUTER COVER 
BACK OUTER COVER 
BINDING SPINE (During the thesis submission after the exam) 

 
 
 
 
 
 
 
 

FRONT PAGES 

INNER COVER 

THESIS APPROVAL 
ETHICS STATEMENT 
DEDICATION (if any) 
ACKNOWLEDGEMENTS 
TABLE OF CONTENTS 
LIST OF TABLES (if any) 
LIST OF FIGURES (if any) 
LIST OF SYMBOLS AND ABBREVIATIONS (if any) 
ÖZET 
ABSTRACT 

 
 
 

THESIS TEXT 

1. INTRODUCTION 

2. GENERAL INFORMATION 

3.  MATERIAL AND METHOD 

4. FINDINGS 

5. DISCUSSION 

6. CONCLUSION, RECOMMENDATIONS AND CONTRIBUTION TO 
SOCIETY 

REFERENCES REFERENCES 
 
 

ADDITIONAL 
DOCUMENTS 

APPENDICES (Data collection forms / institutional permission documents, 
etc.) 
ETHICS COMMITTEE DECISION (If necessary) 
PATENT RIGHT PERMISSION (If necessary) 
COPYRIGHT PERMISSION (If necessary) 
PLAGIARISM REPORT (FIRST PAGE) 
CURRICULUM VITAE 
Blank Page 
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3.1. Outer Cover 

Cover: Cover Spine and Front Outer Cover should be prepared in accordance with the 

format in the thesis writing template. The back outer cover is left blank. All text on the 

cover must be written in Times New Roman 12-point bold capital letters. In the fixed 

binding after the thesis is accepted, attention should be paid to the direction of the spine text 

(from top to bottom). 

3.2. Front Pages 

3.2.1. Inner Cover Page 

It is prepared the same as the front outer cover, except for color. If the thesis was 

supported by TÜBİTAK or similar organizations, this should be stated on the inner cover along 

with the project number. 

3.2.2. Thesis Approval Page 

When the thesis exam is successful, six copies of the Thesis Approval page will be filled 

in, signed in blue ink by the jury members and then the institute director, and placed in the 

relevant place in the hard-bound copies. 

3.2.3. Ethics Statement 

This page is the text of the oath signed by the student. The Ethics Statement is written 

in accordance with the format in the template and signed by the author in blue ink. When the 

thesis exam is passed successfully, this page will be scanned with a scanner and mounted 

electronically in the relevant place in the written thesis. 

3.2.4. Dedication 

The dedication text is written in accordance with the example below, centering the page 

right-left and top-bottom. 

“I dedicate this thesis study to my mother / father / wife / teacher / etc.” 

3.2.5. Acknowledgement 

This page contains a text of acknowledgment to the thesis director, co-advisor, those 

who helped and made special contributions to the thesis, those who allowed the use of 

equipment, laboratories, etc., and the individuals, institutions and organizations who provided 

technical assistance and/or financial support. 

If project support has been received, the supporting institution and project number are 

stated in a separate paragraph. 

3.2.6. Table of Contents 

In the table of contents section, pages of the thesis content are given according to the 

main headings of the thesis and their subheadings. Here, the headings should be written exactly 
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as they are written in the thesis and the correct page numbers should be given. Each line entry 

and the page number must be linked with punctuation. Whenever possible, prefer to create the 

table of contents automatically rather than manually. To automatically create the table of 

contents, follow the steps in the Thesis Template in Chapter 4. 

3.2.7. List of Tables 

If tables are made in the thesis, the titles of these tables and the pages they are on are 

given. Here, too, table titles and page numbers used in the thesis should be given correctly. 

Each line entry and the page number must be linked with punctuation. Prefer to create the list 

of tables automatically rather than manually whenever possible. To automatically create the list 

of tables, follow the steps in Chapter 4, Thesis Template. 

3.2.8. List of Figures 

If a figure is included in the thesis, the list of figures is automatically arranged in 

accordance with the rules followed in the list of tables. 

3.2.9. List of Symbols and Abbreviations 

Abbreviations or symbols acceptable for the relevant discipline should be displayed 

separately in an alphabetical order. Use initials to abbreviate terms occurring frequently in the 

text and consisting of more than one word. Abbreviations should be explained once, upon first 

occurrence in the thesis text. 

Basic and derived units, standard symbols and examples of the International System of 

Units should be used. 

3.2.10. Özet / Abstract 

Place the Özet (abstract in Turkish) after the other parts of the thesis. The summary 

should be written on a separate page. There are no paragraph tabs on this page, italic fonts, 

tables, figures, graphs, physics, chemistry or mathematics formulas, symbols, subscripts, 

superscripts or characters are not used, no references are cited and it should not exceed one 

page. 

Özet Text: This text should not exceed 250 words and should reflect the study as much 

as possible. Be brief and concise; pay attention to word choice and exclude unnecessary words. 

In the Özet text, the subject or purpose of the study, how the study was conducted (material and 

method), main qualitative and quantitative findings, and important results should be given. The 

summary should answer the questions “why the study was done,” “how it was done,” “what 

was found,” and “what the findings mean.” 

Keywords: After the keywords and a colon, type up to five keywords. When selecting 

keywords, Turkish index terms entry in the Thesis Data Entry Form of the Council of Higher 
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Education should be used. Keywords, whether they are proper nouns or not, should start with 

capital letters. Keywords should be listed from general to specific. 

Abstract (written in English): The English text called Abstract is a literal translation 

into English of the Turkish text in the Özet section. In this context, the number of words is not 

taken into account. Key words given after the Turkish Özet should be written in English below 

the English Abstract. It is recommended to choose English keywords in the field of Health from 

"Medical Subject Headings, MeSH Browser". 

3.3. Thesis Text 

The first line of the paragraph should start from the inside with a 1.2 cm tab. Line spacing 

should be 1.5 lines apart from the abstract (1 line), and 6-point (pt) spaces should be given 

above and below the paragraph, and the lines should be justified on both sides. 12-point font 

should be used in the text. At least the first two or last two lines in paragraphs must be on the 

same page (Prevent single remaining line, Widow/Orphan control). Words should not be 

divided by dashes "-" at the end of lines. Titles should not fall on separate pages from the 

subtitles or text that follow them. A space must be left after punctuation marks other than those 

used to separate decimal fractions or numbers. There should be no space after the opening 

parenthesis and before the closing parenthesis. 

 Title Formatting 

 First-level Titles: Chapter titles such as "Thesis Approval", "Ethics Statement", 

"Dedication", "Acknowledgments", "Table of Contents", "List of Tables", "List of Figures", 

"List of Symbols and Abbreviations", "Özet", "Abstract", "Introduction", "General 

Information", "Materials and Methods", "Findings", "Discussion", "Conclusion", "References", 

"Appendices", "Ethics Committee Decision", "Patent Right Permission", "Copyright 

Permission" and "CV" are written in this format. First-level titles start on a new page. A 24-

point (pt) space is left before the title and an 18-point (pt) space is left after it. The title is 

centered in the type area (block of text). Bold uppercase 12-point characters are used. 

 Second-, Third-, and Fourth-level Titles: These titles are written indented on the left 

edge of the writing area. These titles are written in bold, 12-point font and the initial letters of 

the words are capitalized. 12-point space is left before the titles; and 6-point (pt) space is left 

after the titles. Whenever possible, a title degree level further than the fourth level should not 

be used. When writing these titles, first the first-level title (Chapter) is placed, followed by the 

second-, third-, and fourth-level titles, respectively. After the degree numbers, the name of the 

title is written. Dots are placed between them and no spaces are left after the dot. 
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3.3.1. Introduction 

This chapter contains introductory statements about the thesis topic. Brief information that is 

preparatory to the subject is given. The purpose of the study is clearly stated by stating the 

reasons for the need for the thesis study. This chapter usually does not exceed two pages. 

3.3.2. General Information 

In this chapter, basic and classical information that will contribute to the understanding of the 

source information given in the "Introduction" chapter, the methods to be used and other aspects 

of the subject should be given briefly and clearly. Information used in the materials and 

methods, findings, discussion and conclusion chapters should never be included. 

3.3.3. Material and Method 

This is the chapter where the method followed in the research is explained. The basic 

characteristics of the participant-sample or subjects, data collection tools, and the dates when 

the materials or data were collected or the experiments were conducted should be written. It 

should be stated which statistical evaluation was applied to the data. For any research to be 

carried out on living material, permission must be obtained from the relevant ethics committees 

and the approval number for which permission was obtained must be stated in this chapter. 
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3.3.4. Findings 

In this chapter, no information is given from other sources, no data, figures, tables, etc. from 

other sources are included, and the findings and results obtained from the research must be 

stated. The findings should be presented in an order appropriate to the planning of the study. 

The findings obtained in this chapter should be interpreted in an orderly manner by using tables 

and figures, and when necessary, by giving them where they are mentioned (such as Figure 1 

or Table 1). P value should be given clearly in statistical analysis results. 

3.3.5. Discussion 

In this chapter, the findings and the outputs based on the findings are discussed by comparing 

them with other studies. Results that do or do not match the findings and their reasons should 

be compared and based on scientific interpretation. 

3.3.6. Conclusion, Recommendations and Contribution to Society 

At the end of the chapter, the conclusions reached in the light of the information obtained 

from the thesis study should be written briefly and clearly as a paragraph. The extent to which 

the targeted purpose and hypotheses have been achieved, opinions on the scientific importance 

and applicability of the findings, and suggestions for the future are stated in this chapter. In the 

last paragraph, the contribution of the subject to society should be stated. 

3.3.7. Visual Material 

Tables, figures and equations provide the opportunity to present a lot of information in a short 

and understandable way. Information presented in this way is not included in plain text. Figures, 

photographs (pictures), tables, graphs and diagrams should be placed and numbered in 

accordance with the page layout in the relevant chapter of the thesis. The table name should be 

written above the tables, and the figure name should be written below the figure, justified to the 

left. The areas where these expression tools will be placed on the page should not exceed the 

page layout. References to these means of expression in the text should be in accordance with 

them (for example, as seen in Figure 3.1 in the text). Numbering should be done so that the first 

digit indicates the chapter number and the second digit indicates the sequence number of the 

figure/table/image within that chapter (for example, Figure 3.1. Table 3.1). There must be a line 

space (5 mm) between tables, figures, pictures, photographs and the text. 

Table titles, contents and visual subtitles are written in fonts one degree smaller than the main 

text or, when necessary, much smaller (letters can be reduced to 8-point font in case of space 
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constraints); and are written left-aligned, with one or one and a half line spacing, depending on 

how the table fits on the page. Images may be in color provided all copies are identical. Images 

must be originals or very good copies. Standard photocopies are not accepted. In cases where 

it is necessary to add materials such as video, audio recording, etc. other than pictures and 

photographs, the relevant explanation should be made in the text. 

Figure Sample 

 

Figure 3.1: Morphology of NIH/3T3a fibroblast cells 
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Table Sample 

Table 3.1: List of basic SDS-PAGE recipes 

 

3.3.8. Formulas 

Scientific formulas must be written using appropriate notations of the branch of science they 

represent. References must include the formula/equation in the text, numbered in parentheses, 

and the formula/equation should be right-justified. Formulas and equations should not be 

written by hand, but should be created electronically. 

3.4. References 

3.4.1. In-Text Citation 

Each source given in the thesis must be included in the REFERENCES section of the thesis and 

must be prepared in alphabetical order in APA 7 format or numbered in VANCOUVER format. 

The entire thesis should be written in the same references format by choosing one of the 

alphabetical ordering or numbering methods. 

When citing sources in the thesis, the author's surname and source date are given or according 

to their order of use in the text [1], [2], etc. It should be cited by numbering in square brackets. 

Every source given in the thesis should be included. 

If you cite a source according to the author's surname and source date, the following format 

should be followed: 
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Examples: 

It was found that…. (Cannon et al., 2005). 

Cannon et al. (2005) found that…. 

If a figure, table or similar expression tools from different sources will be used, the source must 

be stated in the explanations such as figure captions or table captions. 

If a source with two authors is cited in the text, the surnames of both should be written with the 

separator "and" (for example, Kidder and Mhawi, 2002). If the source has more than two 

authors, the surname of the first one should be written and the other authors should be stated 

with the "et al." abbreviation (e.g. Cannon et al., 2005). 

If more than one source is cited at the same time, they should be listed in chronological order 

and the publications should be separated with a semicolon (for example, Burchett et al., 1999; 

Sipos et al., 2002; Persani et al., 2010). 

If several sources of the same author or group of authors published in the same year are cited 

in the thesis text, the order in the reference section should be taken as basis. The sources should 

be lettered with the letters such as "a, b, ….", adjacent to the source date. (e.g., Burchett et al., 

1999a and Burchett et al., 1999b). 

If you cite a study using the numbering system, the following applies: 

Examples: 

It has been determined that….  [1]. 

If a source with two authors is cited in the text, different numbers appropriate to the order 

should be used for each source (for example [1,2]). 

If more than one source is cited at the same time, numbering is done by placing a "-" sign 

between the first and last source cited (for example, [1-5]). 

3.4.2. End-text References 

All sources should be listed under the "References" title at the end of the thesis. All quotations 

within the text must be cited in the references list. The references list is not numbered with a 

section number, but its pages are numbered. If the source has a DOI number, it is added. In 

references, the first line should start from the inside with a 1.2 cm tab. It should be block text 
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(justified on both sides) with 1.5 line spacing. Set the template according to these criteria and 

do not make changes. 

If the reference list is shown in APA format, the following applies: 

Printed Book Reference List Example 

 
 
 
Book with one or two 
authors 

           Format: Author Surname, Initial(s). (Year). Book Name. City of 
Publishing House: Publishing House. 
(Start words in book names with capital letters) 
 

Murray, C. J., & Lopez, A. D. (1996). Global Burden of 
Disease. Cambridge, MA: Harvard University Press. 

Eren, E. (2016). Yönetim ve Organizasyon. İstanbul: Beta Basım 
Yayım Dağıtım. 

 
Book with multiple 
authors 

Author, A., Author, B., Author, C., Author, D., Author, E., 
Author, F. et al. (Year of Publication). Book name. Place of 
publication: Publishing House. 

 

Different revised 
editions of the 
same book 

Format: Author Surname, Initial(s). (Year). Book Name. (edition 
number). City of Publishing House: Publishing House. 

Kettle, D.S. (1995). Medical and Veterinary Entomology. (2nd 
ed.). Wallingford, UK: CAB International. 

 

 
 
 
 
Article or chapter in 
a book 

Format: Author Surname, Name initial(s). (Year). Name of the 
Chapter in the Book. Inside Editor's Initial Surname (Ed.), Title of the 
book. City of Publishing House: Publishing House, pp. page range. 

Göktan, Ç. (2012). Yirmibirinci Yüzyıla Doğru Fotoğraf Sanatı. 
İçinde F. Bodur (Ed.), Fotoğraf Tarihi. Eskişehir: Anadolu Üniversitesi 
Yayınları, ss.142-174. 

Dalgliesh, R.J. (1993). Babesiosis. İçinde K.S. Warren (Ed.), 
Immunology and Molecular Biology of Parasite Infections. Oxford: 
Blackwell, ss. 352-383. 

 
Book without an 
author mentioned 

        Format: Name of the Work, Publisher, Place of 
Publication Year of Publication.  

       İmlâ Kılavuzu, Türk Dil Kurumu Yayınları, Ankara 2000. 

 
 
 
Translation 

Format: Author Surname, Name initial(s). (Year). Book name. 
(Translator Name Initials Surname) City of Publishing House: 
Publishing House. 

Glesne, C. (2015). Nitel Araştırmaya Giriş. (5. Baskı)(Çev. Ed. 
A. Ersoy, P. Yalçınoğlu). Ankara: Anı Yayıncılık. 
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Journal Article Referencing 

Format Author Surname, Name initial(s). (Year). Article name. Journal name, 
Volume number, page range. 

 
Example of a 
Single-Author 
Journal Article  

 
           Abeysekera, R. (2007). The impact of human resource management 
practices on marketing executive turnover of leasing companies in Sri Lanka. 
Contemporary Management Research, 3(3). doi:10.7903/cmr.94 

 
 
Example of a 
Journal Article 
with Multiple 
Authors 

 
Baranik, L.E.., Roling, E.A. & Eby, L.T. (2010). Why does mentoring 

work? The role of perceived organizational support. Journal of Vocational 
Behavior, 76(1), 366–373. 

 
Bayarçelik, E.B. & Fındıklı, M. (2017). İş tatminin, örgütsel adalet ve 

işten ayrılma niyeti ilişkisindeki aracılık rolü. Beykent Üniversitesi Sosyal 
Bilimler Dergisi, 10(1), 16-31. doi: 10.18221/bujss.303365 

 
Example of a 
Journal Article 
with More 
than Six 
Authors 

 
Tong, Z., Martyn, K., Yang, A., Yin, X., Mead, B. E., Joshi, N., ve ark. 

(2018). Towards a defined ECM and small molecule based monolayer culture 
system for the expansion of mouse and human intestinal stem cells. 
Biomaterials, 154, 60-73. doi: 10.1016/j.biomaterials.2017.10.038 

 

Electronic Resource - Report of an Institution 

               Format: Institution Name. (Year). Report Name. Access: day/month/year, http://net 

address. 

Devlet Planlama Teşkilatı. E-Dönüşüm Türkiye Projesi Kısa Dönem Eylem 

Planı: Değerlendirme Raporu. Erişim: 02 Nisan 2006, 

http://212.175.33.22/kdep/rapor/ KDEPHaziran2004.pdf. 

National Cancer Institute. (2015). Cancer Nanotechnology Plan 2015. 

Erişim: 20.02.2017, https://www.cancer.gov/sites/nano/research/plan/cananoplan-

2015c 

 

Published Thesis 

              Format: Author Surname, Initial(s). (Year). Name of the thesis, University Name, 

Institute Name, Location 

Balbay, Z. (2007) Oryantasyon eğitiminin çalışanların turnoverına etkisi ve 

bir uygulama. Yeditepe Üniversitesi, Sosyal Bilimler Enstitüsü, Yüksek Lisans 

https://doi.org/10.7903/cmr.94
https://doi.org/10.1016/j.biomaterials.2017.10.038
http://212.175.33.22/kdep/rapor/
http://www.cancer.gov/sites/nano/research/plan/cananoplan-2015c
http://www.cancer.gov/sites/nano/research/plan/cananoplan-2015c
http://www.cancer.gov/sites/nano/research/plan/cananoplan-2015c
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Tezi, İstanbul. 

 

Electronic Book 

              Format: Author Surname, Initial(s). (Year). Book name. Publishing House Access: 

day/month/year, http://net address. 

Pilkington, A., & Majumdar, A. (2014). EMQs for the MRCOG Part 2. 

Cambridge University Press. Erişim: 20.04.2020, 

http://www.ebooks.com/1754968/emqs-for-the- mrcog-part-2/pilkington-

andreamajumdar-amitabha/yıl. 

 

Laws and Regulations 

          Format: Name of the Law. (Year in which it was passed). Name of the Journal 

Published, Issue, day month 

          İlköğretim ve Eğitim Kanunu. (1961). T. C. Resmi Gazete, 10705, 12 Ocak 1961. 

 

More about references: 

• The golden rule is to arrange the sources in alphabetical order. 

• Pay attention to the indentations. 

• Pay attention to uppercase and lowercase letters and punctuation. 

For more information about references, visit the APA website. 

(http://www.apastyle.org/learn/faqs/index.aspx). 

 

 

 

 

 

 

http://www.ebooks.com/1754968/emqs-for-the-
http://www.apastyle.org/learn/faqs/index.aspx
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The following applies to references listed in Vancouver format: 

Printed Book Reference List Example 

 
 
 
Book with one or two 
authors 

Format: Author Surname, Name initial(s). Book name (edition 
number), Publishing House, City of Publishing House, Year. 

(Start words in book names with capital letters) 
 

Murray, C. J., & Lopez, A. D., Global Burden of Disease, 
Cambridge, MA, Harvard University Press, 1996. 

Eren, E., Yönetim ve Organizasyon, Beta BasımYayım Dağıtım, 
İstanbul, 2016. 

 
Book with multiple 
authors 

Author, A., Author, B., Author, C. et al. Book name, Place of 
publication: Publishing House, Year of publication. 

 

Different revised 
editions of the 
same book 

Format: Author's Surname, Initial Letter(s)., Book name, (edition 
number), Page Range, Publishing House, City of Publishing House, 
Year. 

Kettle, D.S., Medical and Veterinary Entomology (2nd ed.), CAB 
International, Wallingford, UK, 1995. 

 
 
 
 
Article or chapter in 
a book 

Format: Author's Surname, Initial(s). Book name. Inside: Editor 
Surname Initial(s), ed. Edition Number. City of Publishing House: 
Publishing House; Year. p. 

Göktan Ç., Fotoğraf Tarihi, İçinde: F. Bodur, ed. Eskişehir: Anadolu 
Üniversitesi Yayınları; 2012. s.142-174. 

Dalgliesh, R.J. Immunology and Molecular Biology of Parasite 
Infections. In K.S. Warren, ed. Oxford: Blackwell; 1993. s. 352- 383. 

 
Book without an 
author mentioned 

Format: Name of the Work. Publishing House. Place of 

Publication. Year of Publication. 

 İmlâ Kılavuzu. Türk Dil Kurumu Yayınları. Ankara. 2000. 

 
 
 
Translation 

Format: Author Surname, Name initial(s). Book name. 
Translation: Surname First initial. City of Publishing House: 
Publishing House. Year. 

Glesne, C. Nitel Araştırmaya Giriş. 5. Baskı. Çev. Ed. A. Ersoy, 
P. Yalçınoğlu. Ankara: Anı Yayıncılık. 2015. 

 

Journal Article Referencing 

Format Author Surname, Name initial(s). Article name. Journal name. Year; 
Volume number, page range. 
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Example of a 
Single-Author 
Journal Article 

 
Abeysekera, R. The impact of human resource management practices 

on marketing executive turnover of leasing companies in Sri Lanka. 
Contemporary Management Research. 2007. 3(3). doi:10.7903/cmr.94 

 

 
 
Example of a 
Journal Article 
with Multiple 
Authors 

 
Baranik, L.E.., Roling, E.A. & Eby, L.T. Why does mentoring work? 

The role of perceived organizational support. Journal of Vocational Behavior, 
2010; 76(1), 366–373. 

 
Bayarçelik, E.B. & Fındıklı, M. İş tatminin, örgütsel adalet ve işten 

ayrılma niyeti ilişkisindeki aracılık rolü. Beykent Üniversitesi Sosyal Bilimler 
Dergisi, 2017; 10(1), 16-31. doi: 10.18221/bujss.303365 

 
Example of a 
Journal Article 
with More 
than Three 
Authors 

 
Tong, Z., Martyn, K., Yang, A., ve ark. Towards a defined ECM and 

small molecule based monolayer culture system for the expansion of mouse 
and human intestinal stem cells. Biomaterials, 2018; 154, 60-73. doi: 
10.1016/j.biomaterials.2017.10.038 

 

Electronic Resource - Report of an Institution 

Format: Institution Name. Report Name. Year. (Access Date: day/month/year). Access 

Address: http://... 

Devlet Planlama Teşkilatı. E-Dönüşüm Türkiye Projesi Kısa Dönem Eylem 

Planı: Değerlendirme Raporu. Erişim: 02 Nisan 2006, 

http://212.175.33.22/kdep/rapor/ KDEPHaziran2004.pdf. 

National Cancer Institute. Cancer Nanotechnology Plan 2015. 2015. Erişim: 

20.02.2017, https://www.cancer.gov/sites/nano/research/plan/cananoplan-2015c 

 

Published Thesis 

Format: Author Surname, Initial(s). Name of the thesis (thesis type). Location: University 

Name, Institute Name; Year. 

Balbay, Z. Oryantasyon eğitiminin çalışanların turnoverına etkisi ve bir 

uygulama (tez türü). İstanbul: Yeditepe Üniversitesi, Sosyal Bilimler Enstitüsü, 

Yüksek Lisans Tezi; 2007. 

 

https://doi.org/10.7903/cmr.94
https://doi.org/10.1016/j.biomaterials.2017.10.038
http://212.175.33.22/kdep/rapor/
http://www.cancer.gov/sites/nano/research/plan/cananoplan-2015c
http://www.cancer.gov/sites/nano/research/plan/cananoplan-2015c
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Electronic Book 

Format: Author Surname, Initial(s). Book name. City of Publishing House: Publishing 

House; Year. (Access: day/month/year). Network Address http://... 

Pilkington, A., & Majumdar, A. EMQs for the MRCOG Part 2. Cambridge 

University Press; 2014. (Erişim: 20.04.2020). 

http://www.ebooks.com/1754968/emqs- for-the-mrcog-part-2/pilkington-

andreamajumdar-amitabha/yıl. 

 

Film, short film, documentary, commercial, poster, design 

Format: Director or artist Surname, Initials of the name. (Year) “Movie Name”. IMDB 

Address 

Darabont, F. (1995). “Esaretin Bedeli”. http://www.imdb.com/title /tt0111161 

 

Laws and Regulations 

Format: Name of the Law. (Year in which it was passed). Name of the Journal Published, 

Issue, day month 

İlköğretim ve Eğitim Kanunu. (1961). T. C. Resmi Gazete, 10705, 12 Ocak 1961. 

More about reference list: 

• Arrange the sources in alphabetical order. 

• Pay attention to the indentations. 

• Pay attention to uppercase and lowercase letters and punctuation. 

3.5. Additional Documents 

3.5.1. Appendices 

Some authors may need to attach data/record forms, survey forms, institutional permission 

documents, etc. to the theses. In cases where more than one list of appendices is required, 

separate documents should be created as APPENDIX 1, APPENDIX 2, etc. and should be stated 

separately in the CONTENTS section. The font and size should be the same as in other section 

headings. Page numbering should be done in accordance with the format in each annex list. 

http://www.ebooks.com/1754968/emqs-for-the-
http://www.ebooks.com/1754968/emqs-for-the-
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When the thesis exam is passed successfully, these forms are scanned with a scanner and placed 

in the thesis electronically. 

3.5.2. Ethics Committee Approval 

In studies requiring an ethics committee decision, a photocopy of the ethics committee decision 

is included in the thesis. When the thesis exam is passed successfully, this page is scanned with 

Scanner and placed in the thesis electronically. 

3.5.3. Patent Right Permission 

If the study requires a patent right permission, a photocopy of the permission obtained is 

included in the thesis. When the thesis exam is passed successfully, this page is scanned and 

placed in the thesis electronically. 

3.5.4. Copyright Permission 

Include a photocopy of copyright permission(s) obtained during the writing of the thesis. 

When the thesis exam is passed successfully, this page will be scanned and placed in the 

thesis electronically. 

3.5.5. Plagiarism Report 

A printout of the first page showing the "% similarity rate" of the thesis and the date of the 

report is included in the thesis. 

3.5.6. Curriculum Vitae 

The Curriculum Vitae (CV) is mandatory only for doctoral theses. A short CV is one to two 

paragraphs that describe educational information, schools attended, degrees and achievements 

obtained, and professional experience related to teaching. It should be brief, concise and written 

in the third person singular. The CV is not assigned a section number but is assigned a page 

number is given and is included in the table of contents. It is written in the same font and point 

size as the thesis. 

4. USE OF THE THESIS TEMPLATE 

Do not change the page layout while using the template. 

4.1. Removing Non-Essential Pages 

The Dedication page is not mandatory. Do not include a List of Tables if the author has not 

created any tables; no need to include a List of Figures if there are none in the thesis; no 
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need to include a List of Symbols and Abbreviations if there are none in the thesis; no need 

to include Ethics Committee Approval if an ethics committee decision is not required; no 

need to include a Patent Right Permission if there is no patented method in the thesis; and 

no need to include copyright permission pages if the thesis did not require copyright 

permission from someone else. Update the table of contents after every 

change/addition/deletion you make in the titles. 

 

4.2. Procedures to be Performed in the Thesis Text 

The main thesis text includes sections 1. Introduction - 6. Conclusion and between. 

In the main thesis text, write normal text paragraphs with the “Thesis Text_1.5 Spaced” style. 

THE TEMPLATE IS FORMATTED. PLEASE USE THIS FORMAT. 

Entry of the titles: 

When entering a title, use Styles on the Home tab. 

 

First-level titles have already been entered as “Heading 1, Heading 1.”. Do not try to enter 

them again. For the second-level titles, select “Heading 2, Heading 1.1.” from the Style. Then 

give the title number according to the numbering in the thesis guide and then enter the title. 

Apply the same steps for the third- and fourth-level titles by selecting “Heading 3, Heading 

1.1.1.” or “Heading 4, Heading 1.1.1.1.” using the Style. If you enter the titles this way, you 

can automatically create the table of contents later. Do not create a title further than fourth-

degree ones. 
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4.3. Creating a Table of Contents 

Do not delete the list you encounter on this page 

To create this table, you need to select the second-, third- and the fourth-level titles from the 

style section while writing the Thesis Text (explained in the Headings section). Since the first-

degree titles are already written, you do not need to enter them separately. Use the Custom 

Table command next to the Table of Contents on the References tab. Do not forget to update 

this table after every change you make in the headings. 
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4.4. Add Captions to Figures/Tables/Equations 

Before creating a table of figures, you need to add captions to any figures and tables that you 

want included in your table of figures. 

A caption is a numbered label, such as "Figure 4.1," "Table 4.1," that you can add to a figure, a 

table, an equation, or other object. When numbering, the first digit should indicate the chapter 

number and the second digit should indicate the sequence number of the figure/table/image 

within that section. 

Select the object (table, equation, shape, or another object) you want to caption. 

1. Use the Add Caption command on the References tab. 

 

2. In the incoming Label list, select the tag that describes your image (select “Table” for 

the table title, “Figure” for the figure name (title)). If the list does not provide the 

label you want, click New Label, type the new label in the Label box, and click OK. 
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3. Fill in the "Add section number" box in the window that opens when you click on 

Numbering. In this box, select 1, 2, 3... in "Format" by default, Heading 1 in "Chapter 

start style" and period “.” in " Use Separator" and click "OK". Add a colon “:” and 

a space before the table title or figure name.  
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4.5. Creating a List of Tables/Figures 

Before creating a list of figures/tables, add captions to all the figures and tables included in 

your lists by following the steps above (see Adding Captions to Figures/Tables/Diagrams). 

First, add captions to your tables and figures. 

Place the cursor where you want to insert the table of figures in your document and click. 

Then click Insert Table of Figures. 

 

4.6. Updating the List of Tables/Figures 

If you add, delete, change, or move captions, use the Update Table tab to have the 

figure/table list reflect your changes. 

1. Click the table of figures in your document. This highlights the entire table. 

2. Click References > Custom Table. 

 

Note: Custom table is only an option when you click on the table of figures in your document. 

You can also press F9 to update your table of figures. 

4.7. Özet /Abstract Page 

The text areas on these pages are formatted with the “Abstracts” style. In this style, the 

paragraph does not start from the inside, the lines are single-spaced and there is 6 pt/pt space 

above and below the paragraph. Use the ready format. 

4.8. Placing Signed Pages in the Electronic Thesis Text 

In the printed thesis submitted before the exam, a declaration, ethics committee decision, patent 

right and copyright permissions, if any, must be included. In addition to these, signed approval 

pages must be included in the printed thesis to be submitted after you pass your exam 

successfully. A written thesis in electronic form (written on a CD) is also required when 
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submitting the thesis after the exam. To place the pages, scan them, place them in the electronic 

environment and scale them to fill the page: place the scanned page as a picture on the relevant 

page and click on it with the right mouse button, then click the tabs "Format Image>Edit>In 

Front of Text" and expand the scanned page from the edges to fill the page. 

 


